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BAB IV 

HASIL PENGUJIAN DAN PENGAMATAN 

Pengujian dan pengamatan yang dilakukan penulis merupakan pengujian 

dan pengamatan yang dilakukan terhadap analisis bandwidth dari sistem secara 

keseluruhan yang telah selesai dibuat untuk mengetahui konfigurasi yang 

digunakan dalam sistem ini apakah berjalan dengan baik sesuai yang diharapkan. 

Terdapat beberapa pengujian sistem yang dilakukan, antara lain :  

4.1        Pengujian Perangkat PC Client 

Pengujian yang pertama ini merupakan pengujian yang dilakukan 

terhadap PC Client. Pengujian yang dilakukan terhadap PC menggunakan aplikasi 

PING dimana aplikasi ini yang berfungsi untuk mengetes apakah koneksi sudah 

terhubung atau tidak..  

4.1.1     Tujuan 

Pengujian ini dilakukan untuk mengetahui apakah perangkat PC Client 

yang digunakan dapat berfungsi dengan baik. Indikator keberhasilannya adalah 

PC dapat terhubung dengan server.  

4.1.2     Alat yang digunakan 

Untuk melakukan percobaan ini maka diperlukan beberapa alat. Alat 

yang digunakan diantaranya sebagai berikut : 

a. PC Client 

b. Server 

c. 2 buah Router Mikrotik tipe RB951Ui-2HND 
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d. Program PING 

4.1.3      Prosedur Pengujian 

Prosedur pengujian perangkat : 

a. Aktifkan semua perangkat baik PC Client, router, maupun server.  

b. Buka aplikasi Ping pada PC Client.  

c. Ketik IP Address tujuan yaitu IP Address server dengan perintah “ping 

<ip address server>”.  

Gambar 4.1 Tampilan aplikasi Ping 

d. Setelah proses ping selesai,maka akan keluar tampilan hasil ping. Pada 

bagian ini, program akan menampilkan hasil ping yang menyatakan ping 

berhasil atau tidak.  

4.1.4      Hasil Pengujian 

Pada hasil percobaan diatas apabila langkah ke “d” atau langkah ping ke 

server ini berhasil dikerjakan maka perangkat PC dapat dikatakan bekerja dan 
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mampu berkomunikasi dengan baik. Hasil pengujiannya dapat dilihat pada 

gambar dibawah ini :  

 

Gambar 4.2 Proses Ping dari PC Client menuju Server 

4.2         Pengujian Perangkat Router 

4.2.1      Tujuan 

Pengujian ini dilakukan untuk mengetahui apakah perangkat router yang 

digunakan dapat berfungsi dengan baik. Indikator keberhasilannya adalah Router 

dapat terhubung dengan server.  

4.2.2      Alat yang digunakan 

Untuk melakukan percobaan ini maka diperlukan beberapa alat. Alat 

yang digunakan diantaranya sebagai berikut : 

a. Server 

b. 2 buah Router Mikrotik tipe RB951Ui-2HND 

c. Program PING 
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4.2.3  Prosedur Pengujian 

a. Buka Winbox. Masukkan IP Address Router. 

b. Masuk ke Tools -> Ping.  

 

Gambar 4.3 Tampilan Winbox 

c. Pada bagian ini, isikan Ping to dengan IP Address server. Jika sudah, klik 

Start. 

 

Gambar 4.4 Tampilan Ping 
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4.2.4  Hasil Pengujian 

 Berikut ini adalah hasil pengujian ping pada router menuju server. Hasil 

dari percobaan ditampilkan pada gambar dibawah ini :  

 
Gambar 4.5 Ping dari router menuju server 

4.3   Pengujian Packet Marking (Mangle) 

4.3.1  Tujuan  

Pengujian ini dilakukan untuk mengetahui apakah mangle dapat 

menandai paket data yang melewati router.  

4.3.2  Alat yang digunakan 

Alat yang digunakan untuk pengujian sistem ini antara lain: 

a. PC Client 
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b. Server 

c. 2 buah Router Mikrotik tipe RB951Ui-2HND 

4.3.3  Prosedur Pengujian 

a. Buka PC Client dan Winbox. 

b. Pada PC Client, buka browser dan ketikkan IP Address Server pada address 

bar. 

Gambar 4.6 Tampilan browser pada PC Client 

c. Pada Winbox, pilih IP -> Firewall -> Mangle. Klik HTTP. 

 

Gambar 4.7 Tampilan Mangle 
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d. Pada tampilan HTTP, klik Statistics.  

 

Gambar 4.8 Tampilan Statistics 

e. Kembali ke browser pada PC Client, kemudian download salah satu file.  
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4.3.4  Hasil Pengujian 

 Berikut ini adalah hasil pengujian terhadap packet marking :  

 

Gambar 4.9 Tampilan Packet Marking 

4.4   Pengujian Simple Queue 

4.4.1  Tujuan  

 Pengujian ini bertujuan untuk mengatahui apakah paket yang sudah 

ditandai dapat bekerja pada simple queue .  
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4.4.2  Alat yang digunakan 

Alat yang digunakan untuk pengujian sistem ini antara lain: 

a. PC Client 

b. Server 

c. 2 buah Router Mikrotik tipe RB951Ui-2HND 

4.4.3  Prosedur Pengujian 

a. Buka PC Client dan Winbox. 

b. Pada PC Client, buka browser dan ketikkan IP Address Server pada 

address bar. 

c. Pada Winbox, pilih Queues. Pada tampilan Queue List bagian Simple 

Queues, klik HTTP. 

 

Gambar 4.10 Tampilan Queue List 
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d. Pada tampilan Simple Queue, klik Traffic. 

e. Kembali ke browser pada PC Client, kemudian download salah satu file.  

 

Gambar 4.11 Tampilan Simple Queue 

4.4.4  Hasil Pengujian 

 Hasil pengujian yang dilakukan adalah simple queue dapat aktif sesuai 

dengan yang diharapkan. Berikut ini adalah hasil pengujian yang dilakukan pada 

simple queue : 
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Gambar 4.12 Hasil Simple Queue saat trafik data melewati router 

4.5   Pengujian Sistem 

4.5.1  Tujuan  

Pengujian ini bertujuan untuk mendapatkan data hasil manajemen 

bandwidth yang didapat dari simple queue. Serta menganalisa throughput, packet 

loss, dan delay dari system yang sudah dibuat.  

4.5.2  Alat yang digunakan 

Alat yang digunakan untuk pengujian sistem ini antara lain: 

a. PC Client 

b. Server 

c. 2 buah Router Mikrotik tipe RB951Ui-2HND 

d. Program Wireshark 
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4.5.3 Prosedur Pengujian 

a. Buka PC Client dan Winbox. 

b. Pada PC Client, jalankan Aplikasi Wireshark. 

 

Gambar 4.13 Tampilan aplikasi Wireshark 

c. Pada bagian Capture, pilih interface yang akan dicapture. Jika sudah, klik 

Start. 

 

Gambar 4.14 Tampilan capture Wireshark 

d. Jika data yang ingin dianalisa sudah mencukupi, klik Stop. 
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e. Klik File -> Export Packet Dissections -> as “CSV” file. 

 

Gambar 4.15 Menyimpan kedalam file CSV 

f. Klik File -> Export Packet Dissections -> as “CSV” file. 

4.5.4 Hasil Pengujian 

1. Pengujian HTTP dengan bandwidth 256 kbps 

Berikut adalah hasil statistik dari capture data HTTP dengan bandwidth 

256 kbps : 

 

Gambar 4.16 Hasil Capture Data HTTP Bandwidth 256 kbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 
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ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
275139463
163,705

ൌ 1,  	ݏ݌ܾܯ	68

ݏݏ݋݈	ݐ݁݇ܿܽ݌ ൌ ൬
181738 െ 156770

181738
൰ %100	ݔ ൌ 13,73%	 

ݕ݈ܽ݁݀ ൌ
163,705
181738

ൌ  ݏ	0,0009	

 

2. Pengujian HTTP dengan bandwidth 512 kbps 

Berikut adalah hasil statistik dari capture data HTTP dengan 

bandwidth 512 kbps : 

 

Gambar 4. 17 Hasil Capture Data HTTP Bandwidth 512 kbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 

ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
237799757
144,131

ൌ 1,  	ݏ݌ܾܯ	65

ݏݏ݋݈	ݐ݁݇ܿܽ݌ ൌ ൬
157074 െ 139535

157074
൰ %100	ݔ ൌ 11,17%	 

ݕ݈ܽ݁݀ ൌ
144, 131
157074

ൌ  ݏ	0,0009	
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3. Pengujian HTTP dengan bandwidth 1 Mbps 

Berikut adalah hasil statistik dari capture data HTTP dengan 

bandwidth 1 Mbps : 

 

Gambar 4. 18 Hasil Capture Data HTTP Bandwidth 1 Mbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 

ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
496731443
136,597

ൌ 3,  	ݏ݌ܾܯ	65

ݏݏ݋݈	ݐ݁݇ܿܽ݌ ൌ ൬
328096 െ 320953

328096
൰ %100	ݔ ൌ 2,18%	 

ݕ݈ܽ݁݀ ൌ
136,5971
328096

ൌ  ݏ	0,0004	
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4. Pengujian Video Streaming dengan bandwidth 256 kbps 

Berikut adalah hasil statistik dari capture data Video Streaming dengan 

bandwidth 256 kbps : 

 

Gambar 4. 19 Hasil Capture Data Video Streaming Bandwidth 256 

kbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 

ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
44323670
424,785

ൌ  	ݏ݌ܾܯ	0,104

ݏݏ݋݈	ݐ݁݇ܿܽ݌ ൌ ൬
34876 െ 33910

34876
൰ %100	ݔ ൌ 2,77%	 

ݕ݈ܽ݁݀ ൌ
424,785
34876

ൌ  ݏ	0,0122	
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5. Pengujian Video Streaming dengan bandwidth 512 kbps 

Berikut adalah hasil statistik dari capture data Video Streaming dengan 

bandwidth 512 kbps : 

 

Gambar 4. 20 Hasil Capture Data Video Streaming Bandwidth 512 

kbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 

ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
45485356
439,364

ൌ  	ݏ݌ܾܯ	0,104

ݏݏ݋݈	ݐ݁݇ܿܽ݌ ൌ ൬
35674 െ 34756

35674
൰ %100	ݔ ൌ 2,57%	 

ݕ݈ܽ݁݀ ൌ
439,364
35674

ൌ  ݏ	0,0123	
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6. Pengujian Video Streaming dengan bandwidth 1 Mbps 

Berikut adalah hasil statistik dari capture data Video Streaming dengan 

bandwidth 1 Mbps : 

 

Gambar 4. 21 Hasil Capture Data Video Streaming Bandwidth 1 

Mbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 

ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
44627042
438,990

ൌ  	ݏ݌ܾܯ	0,102

ݏݏ݋݈	ݐ݁݇ܿܽ݌ ൌ ൬
35320 െ 34380

35320
൰ %100	ݔ ൌ 2,66%	 

ݕ݈ܽ݁݀ ൌ
438,990
35320

ൌ  ݏ	0,0124	
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7. Pengujian Game dengan bandwidth 256 kbps 

Berikut adalah hasil statistik dari capture data Game dengan 

bandwidth 256 kbps : 

 

Gambar 4. 22 Hasil Capture Data Game Bandwidth 256 kbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 

ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
644305
580,518

ൌ  	ݏ݌ܾܯ	0,001109

ݕ݈ܽ݁݀ ൌ
580,518
9378

ൌ  ݏ	0,0619	
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8. Pengujian Game dengan bandwidth 512 kbps 

Berikut adalah hasil statistik dari capture data Game dengan 

bandwidth 512 kbps : 

 

Gambar 4. 23 Hasil Capture Data Game Bandwidth 512 kbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 

ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
653761
575,090

ൌ  	ݏ݌ܾܯ	0,001136

ݕ݈ܽ݁݀ ൌ
575,090
9343

ൌ  ݏ	0,0616	
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9. Pengujian Game dengan bandwidth 1 Mbps 

Berikut adalah hasil statistik dari capture data Game dengan 

bandwidth 1 Mbps : 

 

Gambar 4. 24 Hasil Capture Data Game Bandwidth 1 Mbps 

Dari hasil statistik diatas, diperoleh throughput, packet loss, dan delay. 

Perhitungannya adalah sebagai berikut : 

ݐݑ݌݄݃ݑ݋ݎ݄ݐ ൌ
697652
628,220

ൌ  	ݏ݌ܾܯ	0,001111

ݕ݈ܽ݁݀ ൌ
628,220
10235

ൌ  ݏ	0,0614	

 

Berikut adalah hasil perbandingan Simple Queue dan Queue Tree : 

Tabel 4.1 Hasil Perbandingan Simple Queue dan Queue Tree 

Bandwidth / 

Jenis Queue 
Jenis Data 

Throughput 

(Mbps) 

Packet 

Loss (%) 
Delay (s) 

256 kbps / 

Simple 

Queue 

HTTP 1,68 13,7 0,0009 

Video 

Streaming 
0,104 2,77 0,0122 



51 
 

 
 

Bandwidth / 

Jenis Queue 
Jenis Data 

Throughput 

(Mbps) 

Packet 

Loss (%) 
Delay (s) 

256 kbps / 

Queue Tree 

HTTP 3,32 0,000032 0,000428 

Video 

Streaming 
0,303 0,0058 0,00425 

512 kbps / 

Simple 

Queue 

HTTP 1,65 11,17 0,0009 

Video 

Streaming 
0,104 2,57 0,0123 

512 kbps / 

Queue Tree 

HTTP 9,48 0,000052 0,000092 

Video 

Streaming 
0,304 0,0062 0,00423 

1 Mbps / 

Simple 

Queue 

HTTP 3,65 2,18 0,0004 

Video 

Streaming 
0,102 2,66 0,0124 

1 Mbps / 

Queue Tree 

HTTP 8,236777 0,00074 0,00018 

Video 

Streaming 
0,307 0,00643 0,00421 

 

Berdasarkan tabel diatas, didapatkan rata-rata untuk HTTP dengan metode 

Simple Queue sebesar 2,327 Mbps, HTTP dengan metode Queue Tree 

sebesar 7,0123 Mbps, Video Streaming dengan metode Simple Queue 
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sebesar 0,103 Mbps, dan Video Streaming dengan metode Queue Tree 

sebesar 0,305 Mbps. 

 

Berikut adalah hasil perbandingan Simple Queue dengan Mangle , Simple 

Queue tanpa Mangle, dan Queue Tree dengan Mangle : 

Tabel 4.2 Hasil Perbandingan Simple Queue dengan Mangle , Simple 

Queue tanpa Mangle, Queue Tree dengan Mangle dan Queue Tree tanpa 

Mangle 

Jenis Queue Bandwidth 
Throughput 

(Mbps) 

Packet Loss 

(%) 
Delay (s) 

Simple Queue 

+ Mangle 

256 kbps 1,823704 0,00384 0,0077 

512 kbps 2,430458 0,0019 0,00058 

1 Mbps 6,42423 0,0013 0,00022 

Simple Queue 

tanpa Mangle 

256 kbps 0,061 0,0123 0,024 

512 kbps 0,118008 0,001008 0,01204 

1 Mbps 0,244 0,0087 0,0059 

Queue Tree + 

Mangle 

256 kbps 1,9273 0,0025 0,00073 

512 kbps 3,427601 0,00178 0,000411 

1 Mbps 6.365 0,00126 0,00022 

Queue Tree 

tanpa Mangle 

256 kbps 0,0634 0,00066 0,0214 

512 kbps 0,126 0,0082 0,011 

1 Mbps 0,24581 0,000571 0,0055 
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Berdasarkan tabel diatas, didapatkan rata-rata untuk Simple Queue dengan 

Mangle sebesar 3,5595 Mbps, Simple Queue tanpa Mangle sebesar 0,141 

Mbps, Queue Tree dengan Mangle sebesar 3,9066 Mbps, dan Queue Tree 

tanpa Mangle sebesar 0,145 Mbps. 

 

 

 

 

 

 

 

 

 

Gambar 4.25 Grafik trafik data dengan menggunakan Simple Queue dan 

Mangle 
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Gambar 4.26 Grafik trafik data dengan menggunakan Simple Queue tanpa 

Mangle 


